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Package Contents 

Minimum System Requirements 

Note: Using a power supply  with a different voltage than the one included with the 
DWL-7700AP will cause damage and void the warranty for this product.

If any of the above items are missing, please contact your reseller.

 Computers with Windows, Macintosh, or Linux-based operating systems with 
an  installed Ethernet Adapter

 Internet Explorer version 6.0 or Netscape Navigator version 7.0 and above

Package Contents

 D-Link AirPremierTM DWL-7700AP 
 11a/11g Dualband High Speed Outdoor Wireless AP/Bridge
 
 Eight screws & one rubber ring 

 Two rubber dipole antennas

 Manual on CD

 Quick Installation Guide

 2 Mounting Kits
 
 PoE base unit

 Power adapter

 Power cord

 RF jumper cable

 Grounding wire
 
 Surge arrestor 

 30m Ethernet cable



4

DWL-7700AP User’s Manual

D-Link Systems, Inc.

Introduction 
Introduction

The DWL-7700AP covers a large operating distance, providing an 802.11a/g outdoor 
WLAN which enables users to access the Internet or an organization’s network.

The D-Link AirPremierTM DWL-7700AP features a die-cast watertight housing and a built-
in lightning protector to protect the access point from harsh environmental conditions, 
including extreme variance in temperature. It also includes Power over Ethernet (POE) 
and a unique outdoor remote-mounted design for easy installation. With two mounting 
kits, you have the option of either pole or wall mounting.

 The DWL-7700AP is suitable for manufacturing plants, industrial sites, military bases, 
universities, hotels, airports and golf courses.

Configurable in four different modes (access point, bridge, multi-point bridge, and 
wireless client), the DWL-7700AP offers 152-bit encryption, WPA and 802.1X 
authentication when used with a RADIUS server, MAC address access control, and 
additional security features.

The DWL-7700AP is easy to manage with its Web-based user interface and Telnet 
configuration. For Enterprise networks, the DWL-7700AP supports SNMP v.3 network 
administration and real-time network traffic monitoring via D-Link’s D-View Network 
Management software.

At up to five times the speed of previous wireless devices, you can work faster and 
more efficiently, increasing productivity. With the DWL-7700AP, bandwidth-intensive 
applications like graphics or multimedia will benefit significantly because large files are 
able to move across the network quickly. 
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Features and Benefits 
 Ideal for Internet Hotspots - Provides outdoor users with wireless Internet 

access.

 

 



Features and Benefits

Robust Outdoor Housing - Designed for harsh outdoor environments, with 
die-cast, watertight housing, built-in heater and temperature sensor.

4 Different Operation modes with WDS (Wireless Distribution System) - Capable 
of operating in one of four different operation modes to meet your wireless networking 
requirements: access point (AP), Point-to-Point (PtP) bridge, 
Point-to-multipoint (PtMP) bridge, or wireless client.

Embedded DHCP Server automatically assigns IP addresses to wireless clients.

 Connect networks in different buildings when used in conjunction with 
D-Link’s high-gain outdoor antennas.

Easy Installation with 802.3af PoE. 

“Maximum wireless signal rate based on IEEE Standard 802.11a and 802.11g specifications. Actual data throughput will vary. 
Network conditions and environmental factors, including volume of network traffic, building materals and construction, and net-
work overhead lower actual data throughput rate.”

Better security with ACL,WPA, AES and 802.1X- The DWL-7700AP can securely 
connect to wireless clients on the network using WPA (Wi-Fi Protected Access) 
providing a much higher level of security for your data and communications than 
has previously been available. In conjunction with a RADIUS server, 802.1X 
authentication verifies the identity of would-be clients.

 

Compatible with IEEE802.11a and IEEE802.11g standards to provide a wireless 
data rate of up to 54Mbps.* 

 

Backward compatible with the 802.11b standard to provide a wireless data rate 
of up to 11Mbps with 802.11b devices - that means you can migrate your system 
to the 802.11g standard on your own schedule without sacrificing connectivity.

 

Supports up to 152-bit WEP encryption and AES (Advanced Encryption 
Standard).

 

Convenient Network Management with the AP Manager - Manage devices on 
the network with D-Link’s AP Manager.

 

Communicate between IEEE802.11a and IEEE802.11g bands - Optional 
configuration allows communication between bands.

 

Two mounting kits - Gives you the flexibility of either wall or pole outdoor 
mounting.

 
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Four Operational Modes

AP Mode

Bridge Mode
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Using the Configuration Menu 
Using the Configuration Menu

To configure the DWL-7700AP, use a computer which is connected to the DWL-7700AP 
with an Ethernet cable (see the Network Layout diagram).

First, disable the Access the Internet using a proxy server function. To disable this 
function, go to Control Panel > Internet Options > Connections > LAN Settings 
and uncheck the enable box.  

Start your web browser program (Internet Explorer, Netscape Navigator). 

Type the IP address and http port of the DWL-7700AP in the address field           
(http://192.168.0.50) and press Enter. Make sure that the IP addresses of the 
DWL-7700AP and your computer are in the same subnet.

After the connection is established, you will see the user identification window as 
shown. 
Note: If you have changed the default IP address assigned to the DWL-7700AP, make sure to enter 
the correct IP address. 







 Type admin in the User Name field

Leave the Password field blank

Click OK

Note: If you have changed the password, make sure to enter the correct password.
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Using the Configuration Menu

The Home>Wizard screen will appear. Please refer to the Quick Installation Guide for 
more information regarding the Setup Wizard.

These buttons appear on most of the configuration screens in this section. Please 
click on the appropriate button at the bottom of each screen after you have  made a 
configuration change.

Home > Wizard
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Using the Configuration Menu

Home > Wireless > 802.11a 

Service Set Identifier (SSID) is the name designated for a specific 
wireless local area network (WLAN). The SSID’s factory default 
setting is default. The SSID can be easily changed to connect to an 
existing wireless network or to establish a new wireless network.

Enable or Disable SSID broadcast. Enabling this feature broadcasts 
the SSID across the network.

52 is the default channel. All devices on the network must share the 
same channel. (Note: The wireless adapters will automatically scan 
and match the wireless setting.) 

The radio frequency will vary depending on the wireless channel 
that is chosen. The frequency in channel 52 is 5.26GHz. 

SSID:

SSID Broadcast:

Channel:

Radio Frequency:

 

Wireless Band: 802.11a is selected here. 
Choose the wireless band from the pulldown menu.

52

5.26GHz
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Using the Configuration Menu

Home > Wireless > 802.11g 

Service Set Identifier (SSID) is the name designated for a specific 
wireless local area network (WLAN). The SSID’s factory default 
setting is default. The SSID can be easily changed to connect to an 
existing wireless network or to establish a new wireless network.

Enable or Disable SSID broadcast. Enabling this feature broadcasts 
the SSID across the network.

6 is the default channel. All devices on the network must share the 
same channel. (Note: The wireless adapters will automatically scan 
and match the wireless setting.) 

The radio frequency will vary depending on the wireless channel 
that is chosen. The frequency in channel 6 is 2.412GHz. 

SSID:

SSID Broadcast:

Channel:

Radio Frequency:

 

Wireless Band: 802.11g is selected here. 
Choose the wireless band from the pulldown menu.

6
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Home > LAN > Static

Static (Manual) is chosen here. Choose this option if you do not have 
a DHCP server in your network, or if you wish to assign a static IP 
address to the DWL-7700AP.

The default IP address is 192.168.0.50. Assign a static IP address 
that is within the IP address range of your network.

Enter the subnet mask. All devices in the network must share the 
same subnet mask..

Enter the IP address of the gateway in your network. If there isn’t 
a gateway in your network, please enter an IP address within the 
range of your network.

Using the Configuration Menu

Get IP From:

IP Address:

Subnet Mask:

Default Gateway:

 

LAN is short for Local Area Network. This is considered your internal network. These 
are the IP settings of the LAN interface for the DWL-7700AP. These settings may be 
referred to as private settings. You may change the LAN IP address if needed. The LAN 
IP address is private to your internal network and cannot be seen on the Internet.
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Get IP From:

IP Address:

Subnet Mask:

Default Gateway:

 

Home > LAN > DHCP

Using the Configuration Menu

Dynamic (DHCP) is chosen here. Choose Dynamic IP Address to 
obtain an IP Address automatically from a DHCP server in your 
network. 

This field is unavailable when DHCP is chosen.

This field is unavailable when DHCP is chosen.

This field is unavailable when DHCP is chosen.
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Advanced > Mode

Using the Configuration Menu
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Using the Configuration Menu

Wireless Band: Choose IEEE802.11a or IEEE802.11g. IEEE802.11a is chosen 
here.

Access Point:

PtP Bridge:

PtMP Bridge:

AP Client:

Access Point is the default setting. This mode is used to create a 
wireless LAN.

PtP Bridge will allow you to connect two LANs together. The wireless 
bridge mode will  work only with another DWL-7700AP. Click to 
enable and enter the MAC address of the remote bridge.

PtMP Bridge will allow you to connect multiple wireless LANs 
together. Other wireless LANs must be using DWL-7700APs. Click 
to enable and enter up to 16 remote AP MAC addresses.

AP Client will transform any IEEE 802.3 Ethernet device (e.g., a 
computer, printer, etc.) into an 802.11a/g wireless client when it 
communicates with another DWL-7700AP that is acting as an AP. 
Click to enable and enter the MAC address of the root AP.

The DWL-7700AP can be configured to perform in any of four modes: wireless access 
point, wireless bridge, multi-point bridge, and wireless client.



15

DWL-7700AP User’s Manual 

D-Link Systems, Inc.

Using the Configuration Menu

Advanced > Performance

Wireless Band:

Turbo Setting:

Frequency:

Channel:

Data Rate:

Beacon Interval:

Select IEEE802.11a or IEEE802.11g. IEEE802.11a is selected here.

This function is not available in IEEE802.11g. 

The frequency reflects the choice of the wireless band. When 
IEEE802.11a is chosen the frequency is 5.26GHz for channel 52. 
When IEEE802.11g is chosen the frequency is 2.412GHz for channel 
6.

The default channel for IEEE802.11a is 52, and the default channel 
for IEEE802.11g is 6.

The Data Rates are Auto, 1Mbps, 2Mbps, 5.5Mbps, 6Mbps, 9Mbps, 
11Mbps, 12Mbps, 18Mbps, 24Mbps, 36Mbps, 48Mbps, 54Mbps.

Beacons are packets sent by an access point to synchronize a 
network. Specify a beacon interval value. The default (100) is 
recommended.

52

5.26GHz
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Using the Configuration Menu

DTIM:

Fragment Length:

RTS Length:

Transmit Power:

(Delivery Traffic Indication Message) - Select  a setting between 
1and 255. 1 is the default setting. DTIM is a countdown informing 
clients of the next window for listening to broadcast and multicast 

The fragmentation threshold, which is specified in bytes, determines 
whether packets will be fragmented. Packets exceeding the 2346 
byte setting will be fragmented before transmission. 2346 is the 
default setting 

This value should remain at its default setting of 2346. If you 
encounter inconsistent data flow, only minor modifications to the 
value range between 256 and 2346 are recommended

Choose full, half (-3dB), quarter (-6dB), eighth (-9dB), minimum 
power.
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Using the Configuration Menu

Wireless Band:

Access Control:

MAC Address:

MAC Address List:

Select IEEE802.11a or IEEE802.11g. IEEE802.11a is chosen here.

Enter the MAC addresses that you wish to include in your filters list, 
and click Save.

When you enter a MAC address, it appears in this list. Highlight a 
MAC address and click Delete to remove it from the list.

Advanced > Filters > Wireless Access Settings

Select Disabled to disable the filters function.
Select Accept to accept only those devices with MAC addresses in 
the Access Control List.
Select Reject to reject the devices with MAC addresses in the 
Access Control List.
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Using the Configuration Menu

Advanced > Filters > WLAN Partition

Wireless Band: 

Internal Station 
Connection:

Ethernet to WLAN 
Access:

Internal Station 
Connection 

Between 802.11a 
& 802.11g:

Select IEEE802.11a or IEEE802.11g. IEEE802.11a is selected 
here.

Enabling this feature allows wireless clients to communicate with 
each other. If this is disabled, wireless stations of the selected band 
are not allowed to exchange data through the access point.
Enabling this feature allows Ethernet devices to communicate with 
wireless clients. If this is disabled, all data from the Ethernet to 
associated wireless devices is blocked. Wireless devices can still 
send data to the Ethernet.

Enabling this feature allows IEEE802.11a wireless clients to com-
municate with IEEE802.11g wireless clients. 
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The DWL-7700AP has the newest, strongest and most advanced security features 
available today. When used with other 802.11 WPA (Wi-Fi Protected Access) compatible 
products in a network with a RADIUS server, the security features include:

WPA & 802.1x  represent the first line of defense against network intrusion. In the 
authentication process the RADIUS server verifies the identity of the client attempting 
to connect to the network. Unfamiliar clients will be denied access. EAP(Extensible 
Authentication Protocol) is available through the Windows XP Operating System. You 
will need to use the same type of EAP protocol on all the devices in your network when 
using the 802.1x feature. 

WPA (Wi-Fi Protected Access) authorizes and identifies users based on a secret 
key that changes automatically at regular intervals. WPA uses TKIP (Temporal Key 
Integrity Protocol) to change the temporal key every 10,000 packets (a packet is a 
kind of message transmitted over a network.) This ensures much greater security than 
the standard WEP security. (By contrast, the previous WEP encryption implementations 
required the keys to be changed manually.) 

WPA-PSK allows home users that will not incorporate a RADIUS server in their network, 
access to WPA security. Utilizing the Pre-Shared Key mode of WPA, the DWL-7700AP 
will obtain a new security key every time it connects to the 802.11 network. You only 
need to input your encryption information once in the configuration menu. No longer 
will you have to manually input a new WEP key frequently to ensure security. With the 
DWL-7700AP and WPA-PSK, you will automatically receive a new key every time you 
connect, vastly increasing the safety of your communication. 

Advanced > Encryption 

Using the Configuration Menu
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Using the Configuration Menu

Advanced > Encryption > Open System

Wireless Band: 

Authentication:

Ethernet to WLAN 

Select IEEE802.11a or IEEE802.11g. IEEE802.11a is selected here.

Select Open System to communicate the key across the network.

Encryption:

Key Type:

 

Select Enabled or Disabled. When Enabled is selected, as it is here, 
please fill in the following fields.

Select HEX (Hexadecimal digits consist or the numbers 0-9 and 
the letters A-F), or ASCII (American Standard Code for Information 
Interchange) is a code for representing English letters as numbers 
from 0-127.
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Using the Configuration Menu

Advanced > Encryption > Shared Key

Key Size:

Valid Key:

Key Table: 

Select 64-, 128-, 152-bits.

Select one of the keys in the Key table to be the active key.

Enter up to four encryption keys here.

Wireless Band: Select IEEE802.11a or IEEE802.11g. IEEE802.11a is selected here.

Authentication: Select Shared Key to limit communication to only those devices that 
share the same WEP settings.
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Using the Configuration Menu

Encryption:

Key Type:

Key Size:

Valid Key:

Key Table:

 

Enabled is the only option available in Shared Key mode. Please fill 
in the following fields.

Select HEX (Hexadecimal digits consist or the numbers 0-9 and 
the letters A-F), or ASCII (American Standard Code for Information 
Interchange) is a code for representing English letters as numbers 
from 0-127.

Select 64-, 128-, 152-bits.

Select one of the keys in the Key table to be the active key.

Enter up to four encryption keys here.

Advanced > Encryption > Open System/Shared Key 

Wireless Band: Select IEEE802.11a or IEEE802.11g. IEEE802.11a is selected here.
Authentication: Select Open System/Shared Key to communicate the key and         

require identical WEP settings to communicate.
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Encryption:

Key Type:

Key Size:

Valid Key:

Key Table:

 

Enabled is the only option available in Open System/Shared Key 
mode. Please fill in the following fields.

Select HEX (Hexadecimal digits consist or the numbers 0-9 and 
the letters A-F), or ASCII (American Standard Code for Information 
Interchange) is a code for representing English letters as numbers 
from 0-127.

Select 64-, 128-, 152-bits.

Select one of the keys in the Key table to be the active key.

Enter up to four encryption keys here.

Using the Configuration Menu

Advanced > Encryption > 802.1X

Please see the following page for details on the screen shown above.
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Using the Configuration Menu

Advanced > Encryption > 802.1X Authentication

Wireless Band: Select IEEE802.11a or IEEE802.11g. IEEE802.11a is selected here.

Authentication: When you select 802.1X for increased security features with a   RA-
DIUS server, the screen below appears. Select the WEP key size 
and the Authentication type from the pulldown menus.

Encryption:

Key Type:

Key Size:

Valid Key:

Key Table:

Apply:

 

Enabled is the only option available in 802.1X mode. Please fill in 
the following fields.

Select HEX (Hexadecimal digits consist or the numbers 0-9 and 
the letters A-F), or ASCII (American Standard Code for Information 
Interchange) is a code for representing English letters as numbers 
from 0-127.

Select 64-, 128-, 152-bits.

Select one of the keys in the Key table to be the active key.

Enter up to four encryption keys here.

Click Apply in the screen on the previous page. The screen below 
will appear.
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Using the Configuration Menu

WEP Key Size: Select the WEP key size.

Authentication 
From: Select the Authentication source.

Advanced > Encryption > WPA

Wireless Band: Select IEEE802.11a or IEEE802.11g. IEEE802.11a is selected here.

Authentication: When you select WPA for increased security features with a RADIUS 
server, the screen on the next page appears.

Apply: Click Apply and the screen on the next page appears.
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Advanced > Encryption > WPA > Radius Server Setting

Index: Select the indexing order from the pulldown menu

RADIUS Server:

Authentic Port: 

Enter the IP address of the RADIUS server.

1812 is the port number dedicated to the authentication function of 
the RADIUS server.

Accounting Port: Enter the port number dedicated to RADIUS accounting. The RADIUS 
server uses accounting to keep track of user login sessions. 

Key: Enter the secret Key that is required of all devices to communicate 
with the RADIUS server. 

Using the Configuration Menu
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Using the Configuration Menu

Advanced > Encryption > WPA-PSK

Confirm Key:

Status:

Server(s) Settings 
Table: 

Enter the secret key again. 

Select the RADIUS server status. Invalid or Valid.

The servers are listed in sequence with their configuration settings
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Authentication:

Passphrase:
 

WPA-PSK offers enhanced security without the need for a RADIUS 
server. 

Enter a passphrase that will be shared by all devices using 
WPA-PSK on the network.

Wireless Band: Select IEEE802.11a or IEEE802.11g. IEEE802.11a is selected here.

Using the Configuration Menu

Advanced > Grouping

Load Balance: Select Enabled or Disabled. When you Enable Load Balance you 
allow several DWL-7700APs to balance wireless network traffic and 
wireless clients among the DWL-7700APs in the network. 
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DHCP Server 
Control:

IP Assigned From:
 

Using the Configuration Menu

User Limit (0-64):

Link Integrate:

Ethernet Link 
Status:

 

Set the User Limit in this field (0-64).

Select Enabled or Disabled. (When Link Integrate is Enabled, 
and the Ethernet connection between the LAN and the AP is 
disconnected, the wireless segment associated with the AP will also 
be disconnected from the AP.)

This field displays the Ethernet Link Status. Link Up indicates that 
there is an Ethernet LAN connection to the AP. 

Dynamic Host Configuration Protocol assigns dynamic IP 
addresses to devices on the network. This protocol simplifies 
network management and allows new wireless devices to receive 
IP addresses automatically without the need to manually assign 
new IP addresses.
Select Enable to allow the DWL-7700AP to function as a DHCP 
server.

Advanced > DHCP Server > Dynamic Pool Settings

Input the first IP address available for assignment in your network.
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Using the Configuration Menu

The Range of Pool 
(1-255):

SubMask:

Gateway:

Wins:

DNS:

Domain Name:

Lease Time 
(60-31536000 

sec.):

Status:

 

Enter the number of IP addresses available for assignment.

All devices in the network must have the same subnet mask to 
communicate. Enter the submask for the network here.

Enter the IP address of the gateway on the network.

Windows Internet Naming Service is a system that determines the 
IP address of a network computer that has a dynamically assigned 
IP address.

Enter the IP address of the DNS server. The DNS (Domain Name 
Server) translates domain names such as www.dlink.com into IP 
addresses.

Enter the domain name of the DWL-7700AP, if applicable. (An 
example of a domain name is: www.dlink.com.)

The Lease Time is the period of time before the DHCP server will 
assign new IP addresses.

Turn the Dynamic Pool Settings ON or OFF here.
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Using the Configuration Menu

Advanced > DHCP Server > Static Pool Settings

DHCP Server 
Control:

Assigned IP:

Assigned MAC 
Address:

SubMask:

Gateway:
 

Dynamic Host Configuration Protocol assigns IP addresses to 
wireless devices on the network. This protocol simplifies network 
management and allows new wireless devices to receive IP 
addresses automatically without the need to manually assign IP 
addresses.
Select Enable to allow the DWL-7700AP to function as a DHCP 
server. 

Use the Static Pool Settings to assign the same IP address to a 
device at every restart. The IP addresses assigned in the Static Pool  
list must NOT be in the same IP range as the Dynamic Pool. After you 
have assigned a static IP address to a device via its MAC address, 
click Apply; the device will appear in the Assigned Static Pool at 
the bottom of the screen. Edit or delete the device in this list.

Enter the MAC address of the device here.

Enter the subnet mask here.

Enter the IP address of the gateway on the network.
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Wins:

DNS:

Domain Name:

Status:

 

Windows Internet Naming Service is a system that determines 
the IP address of a network computer with a dynamically assigned 
IP address, if applicable.

Enter the IP address of the Domain Name Server, if applicable. 
The DNS translates domain names such as www.dlink.com into IP 
addresses.

Enter the domain name of the DWL-7700AP, if applicable.

This option turns the Static Pool settings ON or OFF.

Using the Configuration Menu

Advanced > DHCP Server > Current IP Mapping List

These are IP address pools to which the DHCP server function has 
assigned dynamic IP addresses. 

This screen displays information about the current DHCP dynamic and static IP 
address pools. This information is available when you enable the DHCP function of the                   
DWL-7700AP and assign dynamic and static IP address pools.

Current DHCP 
Dynamic Pools:
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Binding MAC 
address:

Assigned IP address:

Lease Time:

Current DHCP Static 
Pools:

Binding MAC 
address:

Assigned IP address:

 

The MAC address of a device on the network that is within the DHCP 
dynamic IP address pool.

The current corresponding DHCP-assigned dynamic IP address of 
the device.

The length of time that the dynamic IP address will be valid.

These are IP address pools to which the DHCP server function has 
assigned static IP addresses. 

The MAC address of a device on the network that is within the DHCP 
static IP address pool.

The current corresponding DHCP-assigned static IP address of the 
device.

Using the Configuration Menu

Tools > Admin
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User Name:

Old Password:

New Password:

Confirm New 
Password:

 

Enter a user name. The default setting is admin.

To change your password, enter the old password here.

Enter your new password here.

Enter your new password again.

Using the Configuration Menu

Tools > System

Apply Settings and 
Restart:

Restore to Factory 
Default Settings:

 

Click Restart to apply the system settings and restart the 
DWL-7700AP.

Click Restore to return the DWL-7700AP to its factory default 
settings..
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Update File: After you have downloaded the most recent version of the firmware 
from http://support.dlink.com to your hard drive, you can Browse 
your hard drive to locate the downloaded file. Select the file and click 
OK  to update the firmware.

Using the Configuration Menu

Tools > Firmware
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Update File:

Load Settings to the 
Loacl Hard Drive:

Browse for the configuration settings that you have saved to your 
hard drive. Click OK after you have selected the settings file.

Click OK to save the selected settings to your hard drive.

Using the Configuration Menu

Tools > Cfg File
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Tools > Cfg File > Choose file 

When you click Browse in the previous screen, the dialog box shown above appears.
Select the file you wish to download and click Open. 

When this dialog box appears, click Save and select a location to save the configuration 
file. 

Using the Configuration Menu
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Tools > Misc > Telnet Settings

Using the Configuration Menu

Status:

Timeout:

Telnet is enabled by default.

Select a time period after which a session timeout will occur.

Telnet is a program that allows you to control your network from a single PC.
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Status > Device Info

Using the Configuration Menu

Device 
Information:

This window displays the settings of the DWL-7700AP, the firmware 
version and the MAC address.
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Status > Stats

Using the Configuration Menu

WLAN 802.11A 
Traffic Statistics:

Choose WLAN 802.11A Traffic Statistics, or choose WLAN 
802.11G Traffic Statistics. WLAN 802.11A is chosen here. 
This window displays the statistics of the IEEE802.11a or 
IEEE802.11g network, depending upon your selection.
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Status > Indication

Using the Configuration Menu

Temperature 
Indication: This window displays the current operating temperature.
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Status > Client Info

Using the Configuration Menu

 
Client Information: Select this option to obtain information on IEEE802.11a clients. 

Select WLAN 802.11G Client Information to obtain  information on  
IEEE802.11g clients. (A client is a device on the network that is 
communicating with the DWL-7700AP.)

The following information is available for each client that is communicating with the 
DWL-7700AP.

MAC:

Band:

Authentication:

RSSI:

Power Saving 
Mode:

Displays the MAC address of the client.

Displays the wireless band, 802.11a or 802.11g.

Displays the type of authentication that is enabled.

Receive Signal Strength Indicator indicates the strength of the 
signal

Displays the status of the power saving feature.
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Help

Using the Configuration Menu

Click on any item in the Help screen for more information.Help:
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Using the AP Manager

Using the AP Manager
The AP Manager is a convenient tool to manage the configuration of your network from a 
central computer. With AP Manager there is no need to configure devices individually.

To launch the AP Manager: 
 • Go to the Start Menu
 • Select Programs
 • Select D-Link AirPremier AP Manager
 • Select DWL-7700AP
 

Click on this button to discover the devices available on the network.

Discovering Devices
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Using the AP Manager

Selecting Devices
The AP Manager allows you to configure multiple devices all at once. To select a single 
device, simply click on the device you want to select. To select multiple devices, hold 
down the Ctrl key while clicking on each additional device. To select an entire list, hold 
the Shift key, click on the first AP on the list and then click on the last AP on the list. 

IP Configuration

You can assign an IP address to an AP or assign IP addresses to multiple 
AP’s by clicking on this button after selecting the device(s).

Select the AP that you want to assign an IP address to and click the IP button. Enter 
the IP address and IP netmask for the selected device and click OK. 

You can configure multiple AP’s with IP addresses all at once. Click on the IP button 
after you’ve selected all of the AP’s you want to assign an IP address. Enter the IP 
address you want to assign the first unit and the AP manager will automatically assign 
sequential IP addresses. 



46

DWL-7700AP User’s Manual 

D-Link Systems, Inc.

Using the AP Manager

Device Configuration

Click on this button to access the configuration 
properties of the selected device(s).

The device configuration window allows you to configure settings but does not actually 
apply the settings to the device unless you click the Apply button. You can also save 
and load configuration files from this window. When you load a configuration file, you 
must click Apply if you want the settings to be applied to the selected device(s).

The save button allows you to save a configuration file of the selected 
device settings. Only settings that have a checkmark next to them 
are saved. You cannot save a configuration file if you selected more 
than one device in the device list. 

The Exit button will close the device configuration window. Any 
settings that haven’t been applied will be lost.

The open button is used to load a previously saved configuration file. 
After opening a configuration file, you must click the Apply button to 
save the settings to the selected device(s).

To save settings to the device, you must click the Apply button. Only 
settings that have a checkmark next to them will be applied.

Refresh will revert to the actual device settings of the selected 
device(s).

The Clear Checks button deselects all configurable options. This 
feature is useful if you only want to change a few settings. Deselect 
all items and only check the items that you want to modify. 

The Check All button will select all configurable options. Any setting 
that has a checkmark next to it is applied to the device or saved to 
the configuration file.

You can configure a single device by highlighting one device in the list, or you can 
configure multiple devices by highlighting multiple devices before clicking on the Device 
Configuration icon pictured above. The examples in this section show single device 
configuration. When you select multiple devices for configuration the procedure will be 
similar.
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Using the AP Manager

When selecting multiple devices for configuration, some options are 
unavailable for configuration by default as noted(*) below:

This allows you to change the device name for the selected 
access point. You must place a checkmark in the Device Name 
box to change the name. This option should only be configured 
when one access point is selected for configuration. 

If you’ve selected one device for configuration and you want 
to change the IP address of the device, check the IP Address 
box. You ca then enter an IP address and Subnet Mask for the 
selected access point. This option should only be configurable 
when one access point is selected for configuration. To configure 
multiple devices with an IP address at one time, please reference 
the previous page. 

 Enter the IP address of your gateway, typically your router 
address.

 

 

Device Configuration > General

Device Name(*): 

IP address and 
Subnet Mask(*):

Gateway:



48

DWL-7700AP User’s Manual 

D-Link Systems, Inc.

Using the AP Manager

Device Configuration > General (continued)

  User Limit:

This pulldown selection enables or disables Link Integrity. When 
Link Integrity is enabled, the wireless segment associated with the 
AP will be disconnected whenever the connection between the AP 
and the LAN is dropped.

This pulldown selection enables or disables the ability to Telnet into  
the selected device(s).

This pulldown selection defines the timeout period during a Telnet 
session with the selected device(s).

This pulldown selection enables or disables load balancing. When 
you enable load balance you allow several access points to balance 
wireless network traffic and wireless clients among the access points 
with the same SSID. All the APs that share Load Balancing must 
have the same SSID. Assign each access point a different non-
overlapping channel (e.g., 1, 6, 11).

DHCP client: There is a pulldown menu to select enabled or disabled. When 
enabled, the selected device(s) will function as a DHCP client(s). 
This allows them to receive IP configuration information from a DHCP 
server. When disabled, the access point(s) must have a static IP 
address assigned to them. 

Load Balance:

Enter the number of load balancing users, from 0-64.

Link Integrity:

Telnet Support: 

Telnet Timeout:
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Using the AP Manager

Device Configuration > Wireless > IEEE802.11a

SSID: The Service Set (network) Identifier of your wireless network. 

Channel:  Allows you to select a channel. 52 is the default setting. 

SSID Broadcast: Allows you to enable or disable the broadcasting of the SSID to 
network clients.

Data Rate: 

A pulldown menu to select the maximum wireless signal rate for 
the selected devices(s).

A pulldown menu to select the maximum wireless signal rate for the 
selected devices(s).

A pulldown menu for selecting the transmit power of the selected 
device(s).

Tx Power:

Beacons are packets sent by an access point to synchronize a 
network. Specify the beacon value for the selected device(s) here. 
The default value of 100 is recommended.

Beacon Interval 
(20~1000):
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Device Configuration > Wireless > IEEE802.11a (continued)

Using the AP Manager

Turbo Setting is a group of performance enhancement features that 
increase end user application throughput in an 802.11a network. 
Turbo is backwards compatible with standard 802.11a devices. For 
ideal performance, all wireless devices on the network should be 
Turbo capable. Enable or disable this setting. When Turbo is enabled 
experience a maximum wireless signal rate of up to 108Mbps.*

Turbo Setting:

DTIM (1~255):

This sets the fragmentation threshold (specified in bytes). Packets 
exceeding the value set here will be fragmented. The default is 2346.

Fragment 
Length 

(256~2346): 

The RTS value should not be changed unless you encounter 
inconsistent data flow. The default value is 2346.

RTS Length 
(256~2346):

DTIM (Delivery Traffic Indication Message) is a countdown informing 
clients of the next listening window for broadcast and multicast 
messages.

*Maximum wireless signal rate derived from IEEE Standard 802.11a specifications. Actual data throughput 
will vary. Network conditions and environmental factors lower actual data throughput rate.
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Using the AP Manager

Device Configuration > Wireless > IEEE802.11g

SSID: 

Channel:

SSID Broadcast: Allows you to enable or disable the broadcasting of the SSID to 
network clients.

Data Rate: A pulldown menu to select the maximum wireless signal rate for the 
selected devices(s).

A pulldown menu for selecting the transmit power of the selected 
device(s).

Tx Power:

Beacons are packets sent by an access point to synchronize a 
network. Specify the beacon value for the selected device(s) here. 
The default value of 100 is recommended.

Beacon Interval 
(20~1000):

The Service Set (network) Identifier of your wireless network. 

 Allows you to select a channel. 6 is the default setting. 
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Device Configuration > Wireless > IEEE802.11g (continued)

Using the AP Manager

DTIM (1~255):

This sets the fragmentation threshold (specified in bytes). Packets 
exceeding the value set here will be fragmented. The default is 2346.

Fragment 
Length 

(256~2346): 

The RTS value should not be changed unless you encounter 
inconsistent data flow. The default value is 2346.

RTS Length 
(256~2346):

DTIM (Delivery Traffic Indication Message) is a countdown informing 
clients of the next listening window for broadcast and multicast 
messages.
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Device Configuration > Security > 802.11a & 802.11g 

Using the AP Manager

The Security tab contains the WEP configuration settings on the intial page. If you select 
WPA as the authentication type, an additional tab will appear with the WPA configuration 
options based on your selection. 

The key is communicated across the network.Open:

Shared:

Both:

WPA:

WPA-PSK:

RADIUS:

Local User:

Limited to communication with devices that share the same 
WEP settings.

The key is communicated and identical WEP settings are 
required.

Used to authenticate clients via a RADIUS server.

Does not utilize a RADIUS server for authentication but 
uses a passphrase that is configured on the clients and 
access points.

Authentication 
Type:

Select from the pulldown menu the type of authentication to be used 
on the selected device(s).

Built-in RADIUS server does not require outside server.

A type of 802.1x security that utilizes user login for 
security.
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Device Configuration > Security > 802.11a & 802.11g 

Using the AP Manager

 Key Values: 

Active Key Index:  Select which defined key is active on the selected device(s).

Select the key size (64-bit, 128-bit, or 152-bit) and key type (HEX or 
ASCII) and then enter a string to use as the key. The key length is 
automatically adjusted based on the settings you choose.

Encryption:  Enable or disable encryption on the selected device(s).

Device Configuration > Security > 802.11a > WPA

 
Select the interval during which the group key will be vaild. 1800 is the 
recommended setting. A lower interval may reduce transfer rates. 

Cipher Type: Select Auto, TKIP, or AES from the pulldown menu.

Group Key Update 
Interval:
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Using the AP Manager

Device Configuration > Security > 802.11g > WPA

 
Select the interval during which the group key will be vaild. 1800 is the 
recommended setting. A lower interval may reduce transfer rates. 

Cipher Type: Select Auto, TKIP, or AES from the pulldown menu.

Group Key Update 
Interval:
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Using the AP Manager

Device Configuration > Security > IEEE802.11a & 
IEEE802.11g > RADIUS server

 
Enter the port used on the RADIUS server. 

RADIUS Server: Enter the IP address of the RADIUS server.

RADIUS Port:
 

Enter the RADIUS secret. RADIUS Secret:
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Using the AP Manager

Device Configuration > Security > IEEE802.11a > WPA-PSK

 
Select the interval during which the group key will be valid. 1800 is the 
recommended setting. A lower interval may reduce transfer rates.

Cipher Type: Select auto, TKIP, or AES from the pulldown menu.

Group Key Update 
Interval:

 
Enter a PassPhrase between 8-63 characters in length.PassPhrase:
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Using the AP Manager

Device Configuration > Security > IEEE802.11g > WPA-PSK

 
Select the interval during which the group key will be valid. 1800 is the 
recommended setting. A lower interval may reduce transfer rates.

Cipher Type: Select auto, TKIP, or AES from the pulldown menu.

Group Key Update 
Interval:

 
Enter a PassPhrase between 8-63 characters in length.PassPhrase:
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Using the AP Manager

Device Configuration > Filters

Enabling this allows wireless clients to communicate with each other. 
When this option is disabled, wireless stations are not allowed to 
exchange data through the access point.  

When disabled access control is not filtered based on the MAC 
address. If Accept or Reject is selected, then a box appears for 
entering MAC addresses. When Accept is selected, only devices 
with a MAC address in the list are granted access. When Reject 
is selected, devices in the list of MAC addresses are not granted 
access.  

Enabling this allows wireless IEEE802.11a and IEEE802.11g clients 
to communicate with each other. When this option is disabled, 
IEEE802.11a and IEEE802.11g wireless stations are not allowed 
to exchange data through the access point.  

The following features are configurable in IEEE802.11a & IEEE802.11g:

 Internal 
Station Connect 
Cross 11a, 11g: 

 Internal Station 
Connection: 

Broadcast from 
Ethernet to WLAN:

Enabling this option allows Ethernet devices to communicate with 
wireless clients. When this option is disabled, all data from Ethernet 
to wireless clients is blocked. Wireless devices can still send data to 
the Ethernet devices when this is disabled. 

 Access 
Control: 

Add or Delete MAC addresses in the Access Control List.
 Access 

Control List: 
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Using the AP Manager

Device Configuration > AP Mode

There are 4 AP modes that are configurable in IEEE802.11a & 
IEEE802.11g: 

 Access Point
 PtP Bridge
 PtMP Bridge
 AP Client

AP Client, the default setting used to create a wireless LAN, is 
displayed here.
Please see the following pages for an explanation of the other 4 AP 
modes.

 Access Point: 
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Using the AP Manager

Device Configuration > AP Mode > PtP Bridge

Allows you to connect two wireless LANs together. This only works 
with another DWL-7700AP. If enabled, you must enter the MAC 
address of the other DWL-7700AP.

PtP Bridge: 
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Using the AP Manager

Device Configuration > PtMP Bridge

Allows you to connect multiple wireless LANs together. All other 
LANs must be using DWL-7700APs. When enabled, you must enter 
the MAC address of the other DWL-7700APs. Enter up to sixteen 
addresses.

 PtMP Bridge: 
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Using the AP Manager

Device Configuration > AP Client

In AP Client mode, the DWL-7700AP can be used as a client of a 
DWL-2700AP or another DWL-7700AP. Enter the Root AP MAC 
address of the DWL-7700AP that is acting as an access point in 
the  network.

 AP Client: 
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 Enable or disable the DHCP server function. 

 Enter the initial IP address to be assigned by the DHCP server. 

Enter the number of allocated IP addresses.

 Enter the subnet mask.

Enter the gateway IP address, typically a router.

Wins (Windows Internet Naming Service) is a system that determines 
the IP address of a network computer with a dynamically assigned 
IP address, if applicable.

Click to enable Dynamic Pool Settings. Configure the IP address 
pool in the fields below. 

Click to enable Static Pool Settings. Use this function to assign the 
same IP address to a device at every restart. The IP addresses 
assigned in the Static Pool list must NOT be in the same IP range 
as the Dynamic Pool. 

DHCP Server:

Dynamic Pool 
Settings: 

Static Pool 
Settings: 

IP Assigned From:

Range of Pool (1~255): 

SubMask: 

Gateway: 

Wins: 

Using the AP Manager

Device Configuration > DHCP
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Using the AP Manager

Device Configuration > DHCP (continued)
  The IP address of the DNS server, if applicable.

  Enter the domain name of the DWL-7700AP, if applicable.

  The period of time that the client will retain the assigned IP address.

  This option turns the dynamic pool settings on or off.  

DNS:

Domain Name:

Lease Time:

Status:

Device Configuration > Monitor

  Displays the current operating temperature of the DWL-7700AP.

  When selected, displays the maximum operating temperature.

Receiver Signal Strength Indicator displays the strength of the 
received  signal.

Current Temp:

Temp. Threshold:

RSSI:
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Using the AP Manager

Configuration Files

The DWL-7700AP allows you to save the device settings to a configuration file. To save 
a configuration file follow these steps:
 
 Select a device from the Device List on the main screen of the AP Manager. 

 Click the device configuration button.

 Click the Save button after you have all the settings as you want them.

 A popup window will appear prompting you for a file name and location. Enter the 
file name, choose a file destination, and click Save. 

Device Configuration button.
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You must always click Apply 
in the Configuration window if 
you want the settings to take 
effect.

Using the AP Manager

To load a previously saved configuration file, follow these steps:
 
 Select a device from the Device List on the main screen of the AP Manager. 

  Click the device configuration button.

 Click the Open button.

 A popup window will appear prompting you to locate the configuration file. Locate 
the file and click Open. 

 The configuration file is loaded into the AP Manager but has not actually been 
written to the device(s). If you want to use the newly loaded configuration for the 
selected device(s), click Apply and the configuration settings will be written to the 
device(s).

Device Configuration button.
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Using the AP Manager

To upgrade the firmware:

  Download the latest firmware upgrade from http://support.dlink.com   
   to an easy to find location on your hard drive.

 Click on the firmware button as shown above.

 A popup window will appear. Locate the firmware upgrade file and    
 clickOpen.

You can upgrade the firmware by clicking on this button after 
selecting the device(s).

Firmware







IMPORTANT! DO NOT DISCONNECT POWER FROM THE UNIT WHILE THE 
FIRMWARE IS BEING UPGRADED.
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You can customize the basic System Settings for the 
DWL-7200AP by clicking on this button.

System Settings

Access Password: This sets the admin password for the select device(s).

Auto Refresh: This setting allows you to enable auto refreshing of the network     
device list. By default this option is disabled. If you choose to enable it, you must  
enter the refresh interval in seconds. All other settings on this screen should 
be left at the default setting.

Using the AP Manager
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Setup Wizard

This button will launch the Setup Wizard that will guide 
you through device configuration.

Click Next.

Using the AP Manager
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Setup Wizard (continued)

Enter a Password and retype it in the Verify Password field.

Using the AP Manager

Click Next.
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Setup Wizard (continued)

Enter the SSID and the 
Channel  for the IEEE 
network.

Using the AP Manager

IEEE802.11a

Click Next.

I f  you want to enable 
Encr ypt ion,  enter  the 
Encryption values here.

Click Next.
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Setup Wizard (continued)

Using the AP Manager

IEEE802.11g

Enter the SSID  and the 
Channel for the IEEE
 network. 

Click Next.

If you want to enable 
Encryption, enter the 
Encryption values here.

Click Next.
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Setup Wizard (continued)

Using the AP Manager

The DWL-7700AP setup is complete!
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Using the AP Manager

Refresh

Click on this button to refresh the list of 
devices available on the network.

Devices with a checkmark 
next to them are st i l l 
available on the network. 
Devices with an X are no 
longer available on the 
network.

Click on this button to view the 
version of AP Manager.

About
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Using the Network Setup Wizard in Windows XP

In this section you will learn how to establish a network at home or work, using Microsoft 
Windows XP. 
 
Note:  Please refer to websites such as http://www.homenethelp.com
and http://www.microsoft.com/windows2000  for information about networking computers 
using Windows 2000, Me or 98.

Go to Start>Control Panel>Network Connections
Select Set up a home or small office network

Networking Basics

When this screen appears, click Next.
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Networking Basics

Click Next.

In the following window, select the best description of your computer. If your computer 
connects to the internet through a gateway/router, select the second option as 
shown.

Click Next.

Please follow all the instructions in this window:
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Networking Basics

Enter a Computer description and a Computer name (optional).

Click Next.

Enter a Workgroup name. All computers on your network should have the same 
Workgroup name.

Click Next.



79

DWL-7700AP User’s Manual 

D-Link Systems, Inc.

Please wait while the Network Setup Wizard applies the changes.

When the changes are complete, click Next.

Please wait while the Network Setup Wizard configures the computer. This may take 
a few minutes.

Networking Basics
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Networking Basics

Insert a disk into the Floppy Disk Drive, in this case drive A.

Click Next.

In the window below, select the option that fits your needs. In this example, Create a 
Network Setup Disk has been selected.  You will run this disk on each of the computers 
on your network. Click Next.
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Please read the information under Here’s how in the screen below. After you complete 
the Network Setup Wizard you will use the Network Setup Disk to run the Network 
Setup Wizard once on each of the computers on your network. To continue click 
Next. 

Networking Basics
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Please read the information on this screen, then click Finish to complete the Network 
Setup Wizard.

The new settings will take effect when you restart the computer. Click Yes to restart 
the computer.

You have completed configuring this computer. Next, you will need to run the Network 
Setup Disk on all the other computers on your network. After running the Network 
Setup Disk on all your computers, your new wireless network will be ready to use.

Networking Basics
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Networking Basics

Naming Your Computer

To name your computer n Windows XP, please follow these directions.

 Click Start (in the lower left corner of the screen).

 Right-click on My Computer.

 Select Properties and click.

 Select the Computer Name Tab in the System Properties window.

 You may enter a Computer Description if you wish; this field is optional.

 To rename the computer and join a domain, Click Change.
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 In this window, enter the Computer name.

 Select Workgroup and enter the name of the Workgroup.

 All computers on your network must have the same Workgroup name.

 Click OK.

Networking Basics

The wireless adapter-equipped computers in your network must be in the same IP 
Address range (see Getting Started in this manual for a definition of IP Address Range.)  
To check on the IP Address of the adapter, please do the following:

 Right-click on the Local Area Connection icon in the task bar.

 Click on Status.

Checking the IP Address in Windows XP
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Networking Basics

This window will appear:

 Click the Support tab.

 Click Close.
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Note: DHCP-enabled routers will automatically assign IP addresses to the computers 
on the network, using DHCP (Dynamic Host Configuration Protocol) technology. If you 
are using a DHCP-capable router you will not need to assign static IP addresses.

If you are not using a DHCP capable router, or you need to assign a static IP address, 
please follow these instructions:

 Go to Start.

 Double-click on Control Panel.

Assigning a Static IP Address in Windows 

Networking Basics

 Double-click on Network Connections.
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Networking Basics

 Right-click on Local Area Connections.

 Double-click on Properties.

 Click on Internet Protocol (TCP/IP).

 Click Properties.

 Input your IP address and subnet mask. (The IP addresses on your network 
must be within the same range. For example, if one computer has an IP address 
of 192.168.0.2, the other computers should have IP addresses that are sequential, 
like 192.168.0.3 and 192.168.0.4. The subnet mask must be the same for all the 
computers on the network.)
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 Input your DNS server addresses. (Note:  If you are entering a DNS server, you 
must enter the IP address of the default gateway.)

The DNS server information will be supplied by your ISP (Internet Service Provider.)

 Click OK.

Networking Basics

Assigning a Static IP Address in Macintosh OSX

 Go to the Apple Menu and select System Preferences.

 Click on Network.
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Networking Basics

 Select Built-in Ethernet in the Show pull-down menu.

 Select Manually in the Configure pull-down menu.

 Input the Static IP Address, the Subnet Mask and the Router IP Address in the 
appropriate fields.

 Click Apply Now.
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Networking Basics

 Go to the Apple Menu and select System Preferences.

 Click on Network.

 Select Built-in Ethernet in the Show pull-down menu.

 Select Using DHCP in the Configure pull-down menu.
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Networking Basics

 Click Apply Now.

 The IP Address, Subnet mask, and the Router’s IP Address will appear in a few 
seconds.

Go to Start > Run > type cmd.  A window similar to this one will appear. Type ping 
xxx.xxx.xxx.xxx, where xxx is the IP address of the wireless router or access point. 
A good wireless connection will show four replies from the wireless router or access 
point, as shown.

Checking the Wireless Connection by Pinging 
in Windows XP and 2000
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Troubleshooting

Troubleshooting
This Chapter provides solutions to problems that can occur during the installation and 
operation of the DWL-7700AP Wireless Access Point. We cover various aspects of the 
network setup, including the network adapters. Please read the following if you are 
having problems.

Note:  It is recommended that you use an Ethernet connection to configure the 
DWL-7700AP Wireless Access Point.

1. The computer used to configure the DWL-7700AP cannot access the  
Configuration menu.

 Check that the Ethernet LED on the DWL-7700AP is ON. If the LED is not ON, 
check that the cable for the Ethernet connection is securely inserted.

 Check that the Ethernet Adapter is working properly.  Please see item 3  (Check 
that the drivers for the network adapters are installed properly) in this 
Troubleshooting section to check that the drivers are loaded properly.

 Check that the IP address is in the same range and subnet as the DWL-7700AP.  
Please see Checking the IP Address in Windows XP in the Networking Basics 
section of this manual.

Note:  The IP address of the DWL-7700AP is 192.168.0.50. All the computers on the 
network must have a unique IP address in the same range, e.g., 192.168.0.x. Any 
computers that have identical IP addresses will not be visible on the network. They 
must all have the same subnet mask, e.g., 255.255.255.0.

 Do a Ping test to make sure that the DWL-7700AP is responding. Go to 
Start>Run>Type Command>Type ping 192.168.0.50.  A successful ping will show 
four replies.

Note: If you have changed the default IP address, make sure to ping the correct IP 
address assigned to the DWL-7700AP.
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Troubleshooting

2. The wireless client cannot access the Internet in the Infrastructure mode.

Make sure the wireless client is associated and joined with the correct access point. To 
check this connection:  Right-click on the Local Area Connection icon in the taskbar> 
select View Available Wireless Networks. The Connect to Wireless Network screen 
will appear. Please make sure you have selected the correct available network, as 
shown in the illustrations below.

 Check that the IP address assigned to the wireless adapter is within the same 
IP address range as the access point and gateway. Since the DWL-7700AP has 
an IP address of 192.168.0.50, wireless adapters must have an IP address in the 
same range, e.g., 192.168.0.x.  Each device must have a unique IP address; no two 
devices may have the same IP address. The subnet mask must be the same for all 
the computers on the network.) To check the IP address assigned to the wireless 
adapter, double-click on the Local Area Connection icon in the taskbar > select 
the Support tab and the IP address will be displayed. Please refer to Checking 
the IP Address in the Networking Basics section of this manual.)

 If it is necessary to assign a Static IP Address to the wireless adapter, please refer 
to the appropriate section in Networking Basics. If you are entering a DNS Server 
address you must also enter the Default Gateway Address. (Remember that if 
you have a DHCP-capable router, you will not need to assign a static IP address.  
See  Networking Basics: Assigning a Static IP Address.)
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3.  Check that the drivers for the network adapters are installed properly.

You may be using different network adapters than those illustrated here, but this 
procedure will remain the same, regardless of the type of network adapters you are 
using.

 Go to Start > My Computer > Properties.

Troubleshooting

 Select the Hardware Tab.

 Click Device Manager.
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Troubleshooting

 Double-click on Network Adapters.

 Right-click on D-Link AirPlus DWL-G650 Wireless Cardbus Adapter. (In this 
example we use the DWL-G650; you may be using other network adapters, but the 
procedure will remain the same.) 

 Select Properties to check that the drivers are installed properly.

 Look under Device Status to check that the device is working properly.

 Click OK.
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Troubleshooting

4.  What variables may cause my wireless products to lose reception?

D-Link products let you access your network from virtually anywhere you want. However, 
the positioning of the products within your environment will affect the wireless range.  
Please refer to Installation Considerations in the Wireless Basics section of this 
manual for further information about the most advantageous placement of your D-Link 
wireless products.

5.  Why does my wireless connection keep dropping?

 Antenna Orientation- Try different antenna orientations for the DWL-7700AP. Try to 
keep the antenna at least 6 inches away from the wall or other objects.

 If you are using 2.4GHz cordless phones, X-10 equipment or other home security 
systems, ceiling fans, and lights, your wireless connection will degrade dramatically 
or drop altogether. Try changing the channel on your router, access point and wireless 
adapter to a different channel to avoid interference.

 Keep your product away (at least 3-6 feet) from electrical devices that generate RF 
noise, like microwaves, monitors, electric motors, etc.

6.  Why can’t I get a wireless connection?

If you have enabled encryption on the DWL-7700AP, you must also enable encryption 
on all wireless clients in order to establish a wireless connection.

 Make sure that the SSID on the router and the wireless client are exactly the same.  
If they are not, wireless connection will not be established. 

 Move the DWL-7700AP and the wireless client into the same room and then test 
the wireless connection. 

 Disable all security settings. 

 Turn off your DWL-7700AP and the client. Turn the DWL-7700AP back on again, 
and then turn on the client. 

 Make sure that all devices are set to Infrastructure mode. 

 Check that the LED indicators are indicating normal activity. If not, check that the 
AC power and Ethernet cables are firmly connected.

 Check that the IP address, subnet mask, gateway and DNS settings are correctly 
entered for the network. 

 If you are using 2.4GHz cordless phones, X-10 equipment or other home security 
systems, ceiling fans, and lights, your wireless connection will degrade dramatically 
or drop altogether. Try changing the  channel on your DWL-7700AP, and on all the 
devices in your network to avoid interference.

 Keep your product away (at least 3-6 feet) from electrical devices that generate RF 
noise, like microwaves, monitors, electric motors, etc. 
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7.  I forgot my encryption key.

 Reset the DWL-7700AP to its factory default settings and restore the other devices 
on your network to their default settings. You may do this by pressing the Reset 
button on the back of the unit. You will lose the current configuration settings. 

Troubleshooting
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Technical Specifications

Technical Specifications 
Standards
• IEEE 802.11a
• IEEE 802.11b
• IEEE 802.11g
• IEEE 802.3
• IEEE 802.3u
• IEEE 802.3x

Device Management
• Web-Based – Internet Explorer v6 or later; Netscape Navigator v7 or later; or other Java-enabled 
browsers.
• Telnet
• AP Manager
• SNMP v.3

Data Rate
For 802.11a/g:
• 54, 48, 36, 24, 18, 12, 9 and 6Mbps
For 802.11b:
• 11, 5.5, 2, and1Mbps

Security
• 64-, 128-, 152-bit WEP
• WPA – Wi-Fi Protected Access 
  (WPA-TKIP/AES PSK)
• 802.1x  (EAP-MD5/TLS/TTLS/PEAP)
• MAC Address Access Control List

Wireless Frequency Range
• 2.4GHz to 2.4835GHz
• 5.15GHz to 5.35GHz and
  5.725GHz to 5.825GHz

Wireless Operating Range*
802.11a/g (Full Power with 5dBi gain diversity dualband dipole antenna)
Indoors: 
• 98ft (30m) @ 54Mbps
• 112ft (34m) @ 48Mbps
• 128ft (39m) @ 36Mbps
• 154ft (47m) @ 24Mbps
• 184ft (56m) @ 18Mbps
• 217ft (66m) @ 12Mbps
• 259ft (79m) @ 9Mbps
• 325ft (99m) @ 6Mbps
Outdoors:
• 367ft (112m) @ 54Mbps
• 820ft (250m) @ 18Mbps
• 1640ft (500m) @ 6Mbps

Operating Voltage
• 48VDC +/- 10% for PoE
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Technical Specifications

Radio and Modulation Type
For 802.11b:
DSSS:
• DBPSK @ 1Mbps
• DQPSK @ 2Mbps
• CCK @ 5.5 and 11Mbps
For 802.11a/g:
OFDM:
• BPSK @ 6 and 9Mbps
• QPSK @ 12 and 18Mbps
• 16QAM @ 24 and 36Mbps
• 64QAM @ 48, 54 and 108Mbps
DSSS:
• DBPSK @ 1Mbps
• DQPSK @ 2Mbps
• CCK @ 5.5 and 11Mbps

Transmit Output Power
For 802.11a:
• 100mW (20dBm)
• 50mW (17dBm)
• 30mW (15dBm)
• 20mW (13dBm)
• 10mW (10dBm)
• 5mW (7dBm)
• 1mW (0dBm)
For 802.11b:
• 100mW (20dBm)
• 50mW (17dBm)
• 30mW (15dBm)
• 20mW (13dBm)
• 10mW (10dBm)
• 5mW (7dBm)
• 1mW (0dBm)
For 802.11g:
• 200mW (23dBm)
• 63mW (18dBm)
• 30mW (15dBm)
• 20mW (13dBm)
• 10mW (10dBm)
• 5mW (7dBm)
• 1mW (0dBm)

Receiver Sensitivity
For 802.11a:
• 6Mbps: -85dBm
• 9Mbps: -84dBm
• 12Mbps: -82dBm
• 18Mbps: -80dBm
• 24Mbps: -77dBm
• 36Mbps: -73dBm
• 48Mbps: -69dBm
• 54Mbps: -68dBm
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For 802.11b:
• 1Mbps: -94dBm
• 2Mbps: -91dBm
• 5.5Mbps: -89dBm
• 11Mbps: -85dBm
For 802.11g:
• 1Mbps: -95dBm
• 2Mbps: -91dBm
• 5.5Mbps: -89dBm
• 6Mbps: -90dBm
• 9Mbps: -84dBm
• 11Mbps: -88dBm
• 12Mbps: -82dBm
• 18Mbps: -80dBm
• 24Mbps: -77dBm
• 36Mbps: -73dBm
• 48Mbps: -72dBm
• 54Mbps: -72dBm

Current Consumption
• Max.7W without PoE (without heater)
• Max.8.5W with PoE (without heater)
• Max.27W without PoE (with heater)
• Max.28.5W without PoE (with heater)

LEDs
• Power
• 10/100M
• 802.11a
• 802.11b/g

Temperature
• Operating: -40ºF to 140ºF (-40ºC to 60ºC)
• Storing: -40ºF to 149ºF (-40ºC to 65ºC)

Humidity
• Operating: 10%~90% (non-condensing)
• Storing: 5%~95% (non-condensing)

Certifications
• FCC Part 15
• CSA

Dimensions
• L = 10.93 inches (277.7mm)
• W = 6.10 inches (155mm)
• H = 1.77 inches (45mm)

Warranty
• 1 Year

* Environmental Factors may Adversely Affect Wireless Range
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Contacting Technical Support

You can find  software updates and user documentation on the D-Link website.

D-Link provides free technical support for customers within the United States and within 
Canada for the duration of the warranty period on this product.  

U.S. and Canadian customers can contact D-Link technical support through our web 
site, or by phone. 
 
Tech Support for customers within the United States:

 D-Link Technical Support over the Telephone:
 (877) 453-5465
 Monday through Friday 6:00am to 6:00pm.
 D-Link Technical Support over the Internet:
 http://support.dlink.com
 email:support@dlink.com

Tech Support for customers within Canada:

 D-Link Technical Support over the Telephone:
 (800) 361-5265
 Monday to Friday 8:30am to 9:00pm EST
 D-Link Technical Support over the Internet:
 http://support.dlink.ca
 email:support@dlink.ca

When contacting technical support, please provide the following information:
 ·  Serial number of the unit
 ·  Model number or product name
 ·  Software type and version number

Contacting Technical Support
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Warranty 

Warranty 
Subject to the terms and conditions set forth herein, D-Link Systems, Inc. (“D-Link”) provides this Limited 
warranty for its product only to the person or entity that originally purchased the product from:

· D-Link or its authorized reseller or distributor and
· Products purchased and delivered within the fifty states of the United States, the District of 
Columbia, U.S. Possessions or Protectorates, U.S. Military Installations, addresses with an APO or 
FPO. 

Limited Warranty:  D-Link warrants that the hardware portion of the D-Link products described below 
will be free from material defects in workmanship and materials from the date of original retail purchase 
of the product, for the period set forth below applicable to the product type (“Warranty Period”), except 
as otherwise stated herein. 

1-Year Limited Warranty for the Product(s) is defined as follows:

· Hardware (excluding power supplies and fans) One (1) Year
· Power Supplies and Fans One (1) Year
· Spare parts and spare kits Ninety (90) days

D-Link’s sole obligation shall be to repair or replace the defective Hardware during the Warranty Period 
at no charge to the original owner or to refund at D-Link’s sole discretion.  Such repair or replacement 
will be rendered by D-Link at an Authorized D-Link Service Office.  The replacement Hardware need not 
be new or have an identical make, model or part.  D-Link may in its sole discretion replace the defective 
Hardware (or any part thereof) with any reconditioned product that D-Link reasonably determines is 
substantially equivalent (or superior) in all material respects to the defective Hardware.  Repaired or 
replacement Hardware will be warranted for the remainder of the original Warranty Period from the date 
of original retail purchase.  If a material defect is incapable of correction, or if D-Link determines in its 
sole discretion that it is not practical to repair or replace the defective Hardware, the price paid by the 
original purchaser for the defective Hardware will be refunded by D-Link upon return to D-Link of the 
defective Hardware.  All Hardware (or part thereof) that is replaced by D-Link, or for which the purchase 
price is refunded, shall become the property of D-Link upon replacement or refund.

Limited Software Warranty:  D-Link warrants that the software portion of the product (“Software”) will 
substantially conform to D-Link’s then current functional specifications for the Software, as set forth in the 
applicable documentation, from the date of original retail purchase of the Software for a period of ninety 
(90) days (“Warranty Period”), provided that the Software is properly installed on approved hardware 
and operated as contemplated in its documentation. D-Link further warrants that, during the Warranty 
Period, the magnetic media on which D-Link delivers the Software will be free of physical defects.  D-
Link’s sole obligation shall be to replace the non-conforming Software (or defective media) with software 
that substantially conforms to D-Link’s functional specifications for the Software or to refund at D-Link’s 
sole discretion.  Except as otherwise agreed by D-Link in writing, the replacement Software is provided 
only to the original licensee, and is subject to the terms and conditions of the license granted by D-Link 
for the Software.  Software will be warranted for the remainder of the original Warranty Period from the 
date or original retail purchase.  If a material non-conformance is incapable of correction, or if D-Link 
determines in its sole discretion that it is not practical to replace the non-conforming Software, the price 
paid by the original licensee for the non-conforming Software will be refunded by D-Link; provided that 
the non-conforming Software (and all copies thereof) is first returned to D-Link.  The license granted 
respecting any Software for which a refund is given automatically terminates.

Non-Applicability of Warranty:  The Limited Warranty provided hereunder for hardware and software 
of D-Link’s products will not be applied to and does not cover any refurbished product and any product 
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purchased through the inventory clearance or liquidation sale or other sales in which D-Link, the sellers, 
or the liquidators expressly disclaim their warranty obligation pertaining to the product and in that case, 
the product is being sold “As-Is” without any warranty whatsoever including, without limitation, the Limited 
Warranty as described herein, notwithstanding anything stated herein to the contrary.  

Submitting A Claim:  The customer shall return the product to the original purchase point based on 
its return policy.  In case the return policy period has expired and the product is within warranty, the 
customer shall submit a claim to D-Link as outlined below:

· The customer must submit with the product as part of the claim a written description of the 
Hardware defect or Software nonconformance in sufficient detail to allow D-Link to confirm the same. 
· The original product owner must obtain a Return Material Authorization (“RMA”) number from 
the Authorized D-Link Service Office and, if requested, provide written proof of purchase of the product 
(such as a copy of the dated purchase invoice for the product) before the warranty service is provided.
· After an RMA number is issued, the defective product must be packaged securely in the original 
or other suitable shipping package to ensure that it will not be damaged in transit, and the RMA number 
must be prominently marked on the outside of the package.  Do not include any manuals or accessories 
in the shipping package.  D-Link will only replace the defective portion of the Product and will not ship 
back any accessories.
· The customer is responsible for all in-bound shipping charges to D-Link.  No Cash on Delivery 
(“COD”) is allowed.  Products sent COD will either be rejected by D-Link or become the property of D-Link.  
Products shall be fully insured by the customer. D-Link will not be held responsible for any packages that 
are lost in transit to D-Link.  The repaired or replaced packages will be shipped to the customer via UPS 
Ground or any common carrier selected by D-Link, with shipping charges prepaid. Expedited shipping 
is available if shipping charges are prepaid by the customer and upon request.

· Return Merchandise Ship-To Address
USA: 17595 Mt. Herrmann, Fountain Valley, CA 92708
Canada: 2180 Winston Park Drive, Oakville, ON, L6H 5W1 (Visit http://www.dlink.ca for detailed warranty 
information within Canada)

D-Link may reject or return any product that is not packaged and shipped in strict compliance with the 
foregoing requirements, or for which an RMA number is not visible from the outside of the package. The 
product owner agrees to pay D-Link’s reasonable handling and return shipping charges for any product 
that is not packaged and shipped in accordance with the foregoing requirements, or that is determined 
by D-Link not to be defective or non-conforming.

What Is Not Covered: This limited warranty provided by D-Link does not cover: Products, if in D-Link’s 
judgment, have been subjected to abuse, accident, alteration, modification, tampering, negligence, 
misuse, faulty installation, lack of reasonable care, repair or service in any way that is not contemplated 
in the documentation for the product, or if the model or serial number has been altered, tampered with, 
defaced or removed; Initial installation, installation and removal of the product for repair, and shipping 
costs; Operational adjustments covered in the operating manual for the product, and normal maintenance; 
Damage that occurs in shipment, due to act of God, failures due to power surge, and cosmetic damage;  
Any hardware, software, firmware or other products or services provided  by anyone other than D-Link; 
Products that have been purchased from inventory clearance or liquidation sales or other sales in which 
D-Link, the sellers, or the liquidators expressly disclaim their warranty obligation pertaining to the product.  
Repair by anyone other than D-Link or an Authorized D-Link Service Office will void this Warranty.

Disclaimer of Other Warranties: EXCEPT FOR THE LIMITED WARRANTY SPECIFIED HEREIN, 
THE PRODUCT IS PROVIDED “AS-IS” WITHOUT ANY WARRANTY OF ANY KIND WHATSOEVER 
INCLUDING, WITHOUT LIMITATION, ANY WARRANTY OF MERCHANTABILITY, FITNESS FOR A 
PARTICULAR PURPOSE AND NON-INFRINGEMENT. IF ANY IMPLIED WARRANTY CANNOT BE 
DISCLAIMED IN ANY TERRITORY WHERE A PRODUCT IS SOLD, THE DURATION OF SUCH IMPLIED 

Warranty 
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WARRANTY SHALL BE LIMITED TO NINETY (90) DAYS. EXCEPT AS EXPRESSLY COVERED UNDER 
THE LIMITED WARRANTY PROVIDED HEREIN, THE ENTIRE RISK AS TO THE QUALITY, SELECTION 
AND PERFORMANCE OF THE PRODUCT IS WITH THE PURCHASER OF THE PRODUCT.

Limitation of Liability: TO THE MAXIMUM EXTENT PERMITTED BY LAW, D-LINK IS NOT LIABLE 
UNDER ANY CONTRACT, NEGLIGENCE, STRICT LIABILITY OR OTHER LEGAL OR EQUITABLE 
THEORY FOR ANY LOSS OF USE OF THE PRODUCT, INCONVENIENCE OR DAMAGES OF ANY 
CHARACTER, WHETHER DIRECT, SPECIAL, INCIDENTAL OR CONSEQUENTIAL (INCLUDING, 
BUT NOT LIMITED TO, DAMAGES FOR LOSS OF GOODWILL, LOSS OF REVENUE OR PROFIT, 
WORK STOPPAGE, COMPUTER FAILURE OR MALFUNCTION, FAILURE OF OTHER EQUIPMENT 
OR COMPUTER PROGRAMS TO WHICH D-LINK’S PRODUCT IS CONNECTED WITH, LOSS OF 
INFORMATION OR DATA CONTAINED IN, STORED ON, OR INTEGRATED WITH ANY PRODUCT 
RETURNED TO D-LINK FOR WARRANTY SERVICE) RESULTING FROM THE USE OF THE 
PRODUCT, RELATING TO WARRANTY SERVICE, OR ARISING OUT OF ANY BREACH OF THIS 
LIMITED WARRANTY, EVEN IF D-LINK HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH 
DAMAGES. THE SOLE REMEDY FOR A BREACH OF THE FOREGOING LIMITED WARRANTY IS 
REPAIR, REPLACEMENT OR REFUND OF THE DEFECTIVE OR NON-CONFORMING PRODUCT.  
THE MAXIMUM  LIABILITY OF D-LINK UNDER THIS WARRANTY IS LIMITED TO THE PURCHASE 
PRICE OF THE PRODUCT COVERED BY THE WARRANTY. THE FOREGOING EXPRESS WRITTEN 
WARRANTIES AND REMEDIES ARE EXCLUSIVE AND ARE IN LIEU OF ANY OTHER WARRANTIES 
OR REMEDIES, EXPRESS, IMPLIED OR STATUTORY.

Governing Law:  This Limited Warranty shall be governed by the laws of the State of California. Some 
states do not allow exclusion or limitation of incidental or consequential damages, or limitations on how 
long an implied warranty lasts, so the foregoing limitations and exclusions may not apply. This limited 
warranty provides specific legal rights and the product owner may also have other rights which vary 
from state to state.

Trademarks:  D-Link is a registered trademark of D-Link Systems, Inc. Other trademarks or registered 
trademarks are the property of their respective manufacturers or owners. 

Copyright Statement:  No part of this publication or documentation accompanying this Product may 
be reproduced in any form or by any means or used to make any derivative such as translation, 
transformation, or adaptation without permission from D-Link Corporation/D-Link Systems, Inc., 
as stipulated by the United States Copyright Act of 1976.  Contents are subject to change without 
prior notice.  Copyright© 2002 by D-Link Corporation/D-Link Systems, Inc. All rights reserved.

CE Mark Warning:  This is a Class B product. In a domestic environment, this product may cause radio 
interference, in which case the user may be required to take adequate measures.

FCC Statement:  This equipment has been tested and found to comply with the limits for a Class B 
digital device, pursuant to part 15 of the FCC Rules. These limits are designed to provide reasonable 
protection against harmful interference in a residential installation. This equipment generates, 
uses, and can radiate radio frequency energy and, if not installed and used in accordance with 
the instructions, may cause harmful interference to radio communication. However, there is no 
guarantee that interference will not occur in a particular installation. If this equipment does cause 
harmful interference to radio or television reception, which can be determined by turning the 
equipment off and on, the user is encouraged to try to correct the interference by one or more 
of the following measures:
· Reorient or relocate the receiving antenna.
· Increase the separation between the equipment and receiver.
· Connect the equipment into an outlet on a circuit different from that to which the receiver is  
  connected.
· Consult the dealer or an experienced radio/TV technician for help.

Warranty
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For detailed warranty outside the United States, please contact corresponding local D-Link office. 

FCC Caution: 
The manufacturer is not responsible for any radio or TV interference caused by unauthorized modifications 
to this equipment; such modifications could void the user’s authority to operate the equipment.

(1) The devices are restricted to indoor operations within the 5.15 to 5.25GHz range. (2) For this device 
to operate in the 5.15 to 5.25GHz range, the devices must use integral antennas.

This device complies with Part 15 of the FCC Rules. Operation is subject to the following two conditions: 
(1) This device may not cause harmful interference, and (2) this device must accept any interference 
received, including interference that may cause undesired operation.

IMPORTANT NOTE:  
FCC Radiation Exposure Statement: 
This equipment complies with FCC radiation exposure limits set forth for an uncontrolled environment.  
The antenna(s) used for this equipment must be installed to provide a separation distance of at least 
eight inches (20 cm) from all persons. 
This equipment must not be operated in conjunction with any other antenna.

Warranty 
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Registration 

Registration 

120704

Product registration is entirely voluntary and failure to complete or return 
this form will not diminish your warranty rights.


